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Abbott Informatics technology enables laboratories to standardize processes across multiple sites and automate routine procedures. This leads to improved efficiency and productivity while reducing errors and improving patient safety. The STARLIMS product includes configurable tools to manage complex testing workflows, promptly format and deliver laboratory results to personnel by their preferred method, and manage analyzers and external communications to deliver real-time management information.
Abbott Informatics is an innovator in addressing the needs of the laboratory informatics industry. Our solutions are Laboratory Information Management Systems (LIMS), Electronic Laboratory Notebook (ELN), Scientific Data Management System (SDMS), Advanced Analytics, Mobile Solutions, and Cloud Services. Our true web-based LIMS solution addresses evolving market trends towards centralized LIMS solutions. Abbott Informatics operates a level above, constantly evolving technology that works for today and is future-proof for tomorrow.
Visit http://www.abbottinformatics.com for more information about STARLIMS.
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	Region/Country
	Email Address
	Phone Number

	Americas
	AISupportUS@Abbott.com
	+1 (561) 459-3642

	United Kingdom
	AISupportUK@Abbott.com
	+44 1749 200147
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	AISupportIsrael@Abbott.com
	+972 9 372 0043
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	1-888-455-5467 x250
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	aiSupportAustralasia@Abbott.com
	+61 8 8212 6881

	Asia Pacific
	AISupportAP@Abbott.com
	+852 5808 8820

	Iberia
	AISupportIberia@abbott.com
	+34 91 663 67 64

	Japan
	AISupportJPN@abbott.com
	+81 3 4555 1000

	Netherlands
	AISupport.NL@abbott.com
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Abbott has been one of the world’s most successful companies for more than a century because it has continually transformed itself to meet the changing needs of patients and consumers and to tackle society’s most significant healthcare concerns.
Abbott is a global science-based company, advancing revolutionary technology and delivering localized innovation and value for people in the communities it serves. Abbott is one of the largest global healthcare companies, comprising four equal-sized businesses: diagnostics, medical devices, nutritionals, and branded generic pharmaceuticals.
Abbott’s diversity – across technologies, businesses, geographies and payers – well positions the company to meet and serve demographic trends and global healthcare needs.
Visit http://www.abbott.com for more information.
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[bookmark: 1_abbott_copyright_htm]STARLIMS® is a registered trademark for the STARLIMS product. All Abbott Laboratories product names and trademarks are owned by or licensed to Abbott Laboratories, its subsidiaries, or affiliates. No use of any Abbott trademark, trade name, trade dress, or product name may be made without the prior written authorization of Abbott Laboratories, except to identify the product or services of Abbott Laboratories. All other trademark brands, product names, and trade names are the property of their respective companies.
STARLIMS is a web application for managing laboratory information, workflows, and all aspects of automation for laboratory functions. It is an advanced technology using an internet connection via a web browser to access the features of STARLIMS. STARLIMS connects to Web Services via Microsoft™ Internet Explorer (MSIE) version 11 or higher (Java Script enabled).
STARLIMS is designed to keep personnel in the lab up-to-date with real-time information. Each user in the organization has unique information requirements, and needs access to dissimilar sets of data based on their role in the organization and ongoing real time processes. It provides complete traceability leading to regulatory compliance, without compromising process versatility.
This document contains copyrighted material, trademarks, and other proprietary information. Use hereof, including any reproduction hereof in whole or in part, is governed by the terms of the license agreement that accompanies or is included with the STARLIMS software, or which was entered into separately between you and Abbott Informatics or any of its affiliates. Each person assumes full responsibility and all risks arising from use of the information. All names of people appearing in this document are fictitious. Any resemblance to real persons, living or dead, is purely coincidental.
© 2018 Abbott Informatics. All rights reserved. For more information, contact Abbott Informatics, 4000 Hollywood Blvd., Suite 333 South, Hollywood, FL 33021, USA, +1-954-964-8663.
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[bookmark: _Toc2086714][bookmark: RH_PD_TOC_BK]Introduction
[bookmark: about_this_guide_htm][bookmark: conventions_used_in_this_guide_h_6066][bookmark: _Toc139099622][bookmark: _Toc151361486][bookmark: _GoBack]This document describes the general architecture, hardware and software requirements, and the installation process of STARLIMS v11.7.
[bookmark: _Toc430337309][bookmark: _Toc2086715]Scope
Support the installation of STARLIMS product. 
INTENDED AUDIENCE
· Network administrators
· Database administrators
· IT personnel
This document assumes that the personnel doing the installation are trained IT people, with the proper technical expertise, and with a background in networking and database administration.
[bookmark: _Toc430337310][bookmark: _Toc2086716]Purpose
The purpose of this document is to help readers understand STARLIMS, plan the hardware and software infrastructure, and guide technical personnel through an actual installation.


[bookmark: _Toc2086717]Conventions Used In This Guide
This guide uses the following document conventions when discussing user interface elements:
	Element
	Convention
	Example

	Application Names, Screen Names, Menu Items, Field Names, Subjects, and Tab Names
	Bold
	Open Project

	Links & Buttons
	Underline
	Add

	Variable Data, Database Content, User Input Data, Titles, New Terms, and Tips
	Italic
	Absolute Version

	Message Prompts and Special Characters
	"Quotation marks"
	"Are you sure?"

	Key Names
	<Brackets>
	<Enter>


Application Paths
This guide uses the following format to show paths to applications, windows, and interfaces within the windows:
Console branch > Application window > Pane within the window > Button or Tab


Notices
The following formatting elements alert you to information related to a topic:
	Notice
	Description

	    
[image: ]NOTE 
 
	A note emphasizes or supplements information within the text, but the information is not necessary to complete your task.

	    
[image: ]IMPORTANT 
 
	Important information that is critical to the completion of your task. Read this information to avoid problems and/or wasting your time.

	    
[image: ]TIP 
 
	Tips are helpful hints regarding the functionality or procedures described in this manual.

	    
[image: ]SETTINGS 
 
	Used to notify you of system configurations and/or other settings can affect the way an application, or the system as a whole, appears or functions. Settings can also affect the workflow of an application.

	    
[image: ]WARNING 
 
	Failure to follow these procedures carefully can result in data loss and/or cause other issues with the system. Never skip over warning notices when reading this manual.


[bookmark: about_starlims_v11_htm][bookmark: _Toc430337311]



[bookmark: _Toc2086718]Architecture Diagram
See the two diagrams below and the explanations following them, to understand the different components that make up a STARLIMS installation:




Figure 1: Single Server Architecture Diagram
[image: ]IMPORTANT Customers are responsible for protecting their STARLIMS system components from outside attacks such as Denial of Service (DoS) and other malicious activities. One method of doing this is by introducing a firewall to provide inbound and outbound traffic filtering and monitoring. 

Customers are responsible for ensuring availability of their data. 



Figure 2: High Availability Architecture Diagram
STARLIMS is a multi-tier Web application with the following components:
· Client side logic and GUI running in one of the following:
· Internet Explorer for Internal lab users (XFD forms) (4).
· Any supported browser for External lab users (HTML forms) (4.1)
· Any supported smart phone or tablet for Mobile users (Mobile forms) (4.2)
· Documents Grabber (5) which is a front-end service that monitors certain folders for incoming files and uploads those files into SDMS automatically.
· MS Office clients (6) that expose SDMS functionality from within MS Word, Excel, and Outlook by means of Office plug-ins.
· Server side logic and business rules running in IIS on application Web servers (1).
· STARLIMS Database which contains static and dynamic data such as clients, projects, tests, analytes, orders, results, etc. (3).
· STARLIMS Dictionary which is a database containing business rules, server scripts, client scripts, and client forms definitions (3).
· [bookmark: _Toc430337312]SDMS Database (3) and documents repository (2).
[image: ]IMPORTANT One method of ensuring high availability of data is by backing up the data. It is recommended that you use encrypted removable media for copying and exporting files and that the responsible personnel log this activity.
[image: ]IMPORTANT It is recommended to have the Application Servers and Database Servers on the same time zone. This ensures that DateTime values generated by business logic (which use the Application Server’s time zone), are aligned with DateTime values generated by database functions such as GetDate() for SQL Server, or SYSDATE for Oracle (which use Database Server’s time zone).
For more information, please consult the “Working with DateTime values” section from User Documentation included with the media.


[bookmark: _Toc2086719]System Requirements
NOTE: These minimum requirements apply to out-of-the-box STARLIMS products with no customizations. They do not cover quantity for high availability or disaster recovery. In addition, these requirements are the minimum hardware configurations required when considering up to 100 concurrent users. Concurrent users include any connection to STARLIMS by either a human, instrument, or a batch service running concurrently.
The requirements on this page are for the STARLIMS software and exclude any other client/server requirements.
[bookmark: _Toc450312535][bookmark: _Toc2086720]Client Requirements
[bookmark: _Toc2086721]Standard STARLIMS Client
NOTE: Client requirements for RAM, CPU, and DISK depend on your Operating System as well as any other software you use on your computer. For example, Windows 10 requires at minimum 2GB of RAM, 1 GHz processor, and 20GB of disk space for 64 bit clients. Abbott Informatics recommends that your client have enough memory, processing power, and disk space to support Windows, STARLIMS, and any other software you use concurrently with STARLIMS.

	CLIENT OS
	Windows 7
Windows 8.1
Windows 10

	RAM
	1GB

	CPU
	2.0 GHz

	DISK
	1GB

	DISPLAY
	1920x1080 (Reccomended for Modern (HTML5) Runtime)

	OTHER
	.NET 3.5.1 (for XFD Functionality within IE 11)
.NET 4.6 (for STARLIMS Bridge functionality)
SAP Crystal Reports 13 SP5 Runtime
SAP Crystal Reports 2013 (for Custom Report Creation, if needed)
Adobe Reader
Microsoft Office


NOTE: If you have a high DPI monitor with DPI scaling enabled, then your scaled DPI must have a resolution that is at least 1920x1080 (1080p) after scaling. For example, if you have a 4K monitor with DPI scaling at 200%, than your scaled resolution will be 2K (1080p).


[bookmark: _Toc2086722]Browsers

	CLASSIC (XFD) SITE
	IE 11

	MODERN (HTML5) SITE
	Chrome, Firefox


NOTE: Starting with Technology Platform version 11.5, the HTML5 runtime no longer supports IE 11.


[bookmark: _Toc2086723]Application Server Requirements
NOTE: You can use virtualization for the Application Server. In addition, it is recommended to have multiple storage drives in RAID configuration for redundancy.
	

	SERVER OS
	Windows Server 2008 R2 SP1 (64 bit)
Windows Server 2012 R2 (64 bit) (Refer to following Windows Server 2012 pre-requisites section)
Windows Server 2016 (64 bit)

	CPU
	4 Cores @ 2.5 GHz

	RAM
	8GB

	DISK
	100 GB - Minimum Recommended HDD Space Varies by Implementation

	OTHER
	.NET 4.6.2
Microsoft IIS 7.5 or later, depending on OS
OpenText RightFax Client 10.6 (for RightFax Support)
Oracle Data Access Components (ODAC) 12.2.0.1.1 (for ORACLE Databases)





[bookmark: _Toc2086724]Batch Server Requirements
NOTE: You can use virtualization for a STARTLIMS Batch Server. In addition, it is recommended to have multiple storage drives in RAID configuration for redundancy.

	SERVER OS
	Windows Server 2008 R2 SP1 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2016 (64 bit)

	CPU
	4 Cores @ 2.5 GHz

	RAM
	8GB

	DISK
	100 GB - Minimum Recommended HDD Space Varies by Implementation

	OTHER
	.NET 4.6.2
Microsoft IIS 7.5 or later, depending on OS
Oracle Data Access Components (ODAC) 12.2.0.1.1 (for ORACLE Databases)


[bookmark: _Toc2086725]SDMS Server Requirements
NOTE: You can use virtualization for a STARTLIMS SDMS Server. In addition, it is recommended to have multiple storage drives in RAID configuration for redundancy.

	
SERVER OS
	Windows Server 2008 R2 SP1 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2016 (64 bit)

	CPU
	4 Cores @ 2.5 GHz

	RAM
	8GB

	DISK
	Minimum Recommended HDD Space Varies by Implementation

	OTHER
	.NET 4.6.2
Microsoft IIS 7.5 or later, depending on OS
Oracle Data Access Components (ODAC) 12.2.0.1.1 (for ORACLE Databases)





[bookmark: _Toc2086726]Database Server Requirements
	

	DATABSE SYSTEM
	SQL 2014 SP1
SQL 2016
SQL 2017
ORACLE 11G
ORACLE 12C
ORACLE 18C

	RAM
	16GB

	CPU
	4 Cores @ 2.5 GHz

	DISK
	Varies by Implementation
SSD or SAN RAID 1+0 with 15K FC drives recommended

	OTHER
	Physical Server – Virtualization possible, but not recommended
You must configure your application server and database server with the same time zone. This ensures that datetime values that use the application server’s time zone, are aligned with datetime values generated by database functions that use database server’s time zone. For example, getdate for SQL Server or sysdate for ORACLE.



WARNING: Abbott Informatics does not recommend production database virtualization. Virtualization of the STARLIMS database server is supported, but not recommended for all customer environments. In the case of performance issues, if Abbott Informatics cannot reproduce the issue in a similar environment utilizing physical hardware, Abbott Informatics will then be unable to offer further assistance in recommendations to underlying infrastructure when virtualization has been utilized.
In the case of database virtualization, the recommendation is to ensure that the underlying physical hardware in not over allocated at the virtual machine level. To ensure the database has adequate resources in the virtual machine, the recommendation is to dedicate 1:1 physical host memory, physical CPU and physical disk allocation. The recommendation before implementation of a STARLIMS database in a virtual environment is to conduct proper load testing in the virtual environment to ensure the performance is acceptable for your business.




[bookmark: _Toc2086727]SERVER ROLES
Application Server
· .NET Framework 4.5
Web Server (IIS)
· Web Server
· Common HTTP Features (All Items)
· Health and Diagnostics (All Items)
· Performance (All Items)
· Security	
· Request Filtering
· Basic Authentication
· Windows Authentication
· Application Development
· .NET Extensibility 3.5
· .NET Extensibility 4.5
· Application Initialization
· ASP.NET 3.5
· ASP.NET4.5
· ISAPI Extensions
· ISAPI Filters
· Management Tools (All Items)
[bookmark: _Toc2086728]SERVER FEATURES
.NET Framework 3.5 Features (All Items)
.NET Framework 4.5 Features
· .NET Framework 4.5
· ASP.NET 4.5
· WCF Services
· TCP Port Sharing
[bookmark: _Toc430337316]

[bookmark: _Toc2086729]STARLIMS Installation
[bookmark: _Toc430337317][bookmark: _Toc2086730]Restore Databases
The install kit contains the following:
· STARLIMS Database
· STARLIMS Dictionary
These are delivered either as SQL Server backups (.bak), or as Oracle dump files (.dmp). Restore them to the RDBMS server using appropriate SQL Server or Oracle specific utilities. Consult SQL Server or Oracle documentation for details. 
[image: ]IMPORTANT For Oracle, make sure to restore each dump in its own schema. For example, create new schemas named "STARLIMS_DATA" and "STARLIMS_DICT" and use them to restore the database and dictionary. Special characters such as dot (.), comma (,), dash (-), must be avoided in Database and Dictionary names.
STARLIMS requires database accounts that are able to connect and execute DML, DDL, DCL, and TCL statements such as select, insert, delete, update, create, alter, drop, grant, revoke, set transaction, commit, rollback, and so on, against any table in the database and the dictionary. Also, the database accounts must be able to execute stored procedures and user-defined functions. 
Do the following to allow this access:
For SQL Server, join the database accounts to the following roles: db_datareader, db_datawriter, db_ddladmin, and db_securityadmin. To enable database accounts to execute stored procedures and user defined functions, you can run a statement like GRANT EXECUTE TO user_name. Replace user_name with the actual database account name.
[image: ]NOTE It is a good practice to avoid using the dash character in SQL Server database user names, such as sa-dev, or sa-test. Instead create users such as sadev or satest. This is recommended because the Grant Execute statement does not handle the dash character (-) in some SQL Server versions.
For ORACLE, the database accounts need to be members of the following:
· Roles: 
· CONNECT
· RESOURCE
· System:
· UNLIMITED TABLESPACE
To enable Oracle database accounts to execute stored procedures and user defined functions, run a statement such as GRANT EXECUTE ANY PROCEDURE TO user_name, replacing user_name with the actual schema name.
Password is not mandatory and may be company-configurable based on the company’s policy, after IT personnel create the users. STARLIMS does not require any locked passwords. The TABLESPACES used are the default. This is the Oracle standard used. USERS and TEMP are defaults of Oracle for the installation of the database and application. If a customer wants to change the TABLESPACES, that will be at their discretion.
It is necessary to create the required TNS names, using Oracle Net Manager or other appropriate utilities, to be used in the next section. This must be done for each of the Application Server machines.
The Oracle database must be configured to use the Unicode character set (AL32UTF8).
[bookmark: _Toc430337318][bookmark: _Toc2086731]Install the STARLIMS Website
Log on to the Application Server, using a Windows administrator account. 
Before running the installer, you must extract the installation kit’s files to a folder with a short name within a drive’s root directory (for example, C:\tempinstall or C:\temp). This is because windows has a maximum file path length limit of 260 characters. If you extract the contents to another folder on your machine, you may exceed the maximum path length limit. This will cause the upgrade to fail as it cannot locate files in the directory.
Run Setup.exe to open the STARLIMS installation wizard. The wizard will guide you as you install the following four components:
· STARLIMS website. This is the actual STARLIMS installation. 
[image: ]NOTE At the wizard step that prompts for the application base folder, avoid using “Program Files.” In general, keep the folder structure and names as short as possible.
· System Management Tool (STARLIMS Console). This is an MMC snap-in tool, which lets you configure STARLIMS post-installation. See STARLIMS Manager Console Installation section for details.
· STARLIMS Printing Service. This is optional, and can be scaled out to a different machine. See Report Printing Service Installation Guide section for details.
· STARLIMS Manager Service. This is also optional, and can be scaled out to a different machine. See Manager Service Configuration section for details.
By default, each of the four components is checked, meaning it will be installed. If you uncheck any component, it will not be installed (and if already installed, it will be uninstalled). This gives you flexibility in deployment; for example you can scale out Printing Service or Manager Service on their own, dedicated servers, in order to preserver resources on main app server.
If you are using a Network Load Balancing (NLB) solution for high availability and scalability, repeat the STARLIMS installation process on each application server.
 [image: ]IMPORTANT If you install the Manager Service on a different server, the WorkPath folder must be a network shared folder. You can configure the WorkPath location after installing STARLIMS, by using the System Management Tool (STARLIMS Console) mentioned above. For instructions on configuring the Manager Service, see STARLIMS Manager Service Configuration.
By default, the websites are limited to two users for each type of license. To register the site and enable the number of users you purchased, refer to Registering the STARLIMS Installation for instructions.
[bookmark: _Toc430337320][bookmark: _Toc2086732][bookmark: _Toc430337322][bookmark: _Toc430337319]Network Load Balancing Considerations
When running the STARLIMS website under a Network Load Balancing (NLB) environment, you need to share the user log and work path folders. To specify the location of these folders, you need to run the STARLIMS Console on each application server in the cluster, and change the settings "UserLogFolder" and "WorkPathFolder" so that they point to the correct network shares. 
[image: ]NOTE Both network folders must be configured so they grant full read / write access to the accounts impersonated by the STARLIMS websites, that is, the local Network Service or some domain account.
[bookmark: _Toc2086733]IIS Application Pool Configuration
After installing the STARLIMS website, open IIS and check Application Pool settings. 
1. Open Internet Information Services (IIS) Manager.
2. Locate and select Application Pool.
3. In the resulting list, select the [STARLIMS Website Name], select Recycling from the drop-down menu. 
4. In the dialog box, make sure all numeric settings are set to “0” (zero). Close the dialog box.
5. With the STARLIMS website name still in context, select Advanced Setting from the drop-down menu. 
6. In the Advanced Settings dialog box, select Process Model and set the Idle Time-out (minutes) to “0” (zero). 
7. Still in the Advanced Settings dialog box, select Identity. Select the Network Service Account (recommended). Exit IIS.
8. Make sure that application pool identity account (e.g. Network Service) has full rights to the following:
·  STARLIMS application folder and subfolders. This is the parent of the folder specified by "ApplicationBaseFolder" setting from web.config or the STARLIMS Console.
· STARLIMS work path folder. This is the folder specified by the "WorkPathFolder" setting from web.config or the STARLIMS Console.
· Windows system TEMP folder (usually C:\Windows\Temp).
· [bookmark: _STARLIMS_Manager_Console_1][bookmark: _Toc228679249][bookmark: _Toc430337342]Registry key [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog].
[bookmark: _Toc2086734]STARLIMS Management Console Installation
The STARLIMS Console is used to inspect and modify settings of an installed site. To install the console:
1. As an administrator, open Windows Start, type mmc.exe in the run box, and press <Enter>. The Console1 window opens.
2. Click the File menu and select Add/Remove Snap-in.
3. In the list of available snap-ins, select “STARLIMS Management Console” and then click Add.
4. Click OK in the Add or Remove Snap-ins window. You should see the following:
[image: ]
Figure 3: STARLIMS Console Added to Console Root
5. Click STARLIMS Console on the left side of the window and click List Available Servers on the main page of the snap in. 
6. In the list of available websites displayed, select (check) the names of the websites that you want to configure and/or manage and click OK.
7. Click the Web Sites tab to view the selected server names with their websites and their absolute paths.
8. In the Configuration tab, click on a website. All settings and connection information used by STARLIMS will appear:
[bookmark: _Ref228603976][image: C:\Users\codrecx\AppData\Local\Temp\SNAGHTML9b84a9ee.PNG]
Figure 4: Console Configuration Tab
9. Click an item that you want to update and follow the instructions shown on the screen.
Some of the settings found under the Configuration tab shown, are used internally by STARLIMS and are not intended to be changed by the end-users unless confident in their ability to do so. See the caution below. 
[image: ]WARNING Improper configuration of the items listed below may result in an unstable or unusable application, consult your Abbott Informatics Representative before you perform this activity, when necessary.
Descriptions of the settings are as follows:
· STARLIMS Anonymous User and STARLIMS Anonymous Password - Used internally by STARLIMS to make the initial call that comes from the client. The username and the password cannot be changed by the end-user.
· Application Base Folder – The folder where all the DLL files used by the STARLIMS compiler reside. The path can be changed by clicking on the text box.
· Shadow Cache Folder – Used internally by the STARLIMS compiler. The path can be changed by clicking on the text box.
· Global Cache Folder – Used together with Global Cache Type. In this case it is the Database. So, if the Global Cache is kept in the database, this setting is empty. This setting together with Global Cache Type should not be changed by end-user, as it could cause caching synchronization issues.
· Local Cache Folder – The folder on the system where cached DLL files are kept. This folder has to be inside the \bin folder, so if the path is modified by the end-user the folder structure should be \bin\LocalCache.
· Compiler output folder - Used internally by the STARLIMS compiler. The path can be changed by clicking on the text box.
· Global Cache Type – See note on Global Cache Folder.
· File Log Folder and User Log Folder – Denote where the logs from the system and users are kept, respectively. The paths can be changed by clicking on the text box.
· Reporting Enable Debugger and Reporting Debugger Folder – A debug directive used internally by the STARLIMS reporting services.
· Reporting Enable Performance Log and Reporting Performance Log File Name – A flag, and a file name respectively, that should not be changed by the end-user. It is used by the STARLIMS R&D team to monitor the state of the STARLIMS reporting services.
· Reporting Enable Set Location – A flag used internally by the STARLIMS reporting services. It should not be changed by the end-user.
· Recycle Application Domains – A setting that contains rules used internally by STARLIMS. Its value is controlled by changing the Server Configuration value to either Production Mode or Development Mode.
· Unique Application Domain – Another setting used internally by STARLIMS. Its value is controlled by changing the Server Configuration value to either Production Mode or Development Mode.
· Use Compression - Another setting used internally by STARLIMS – it should not be changed by the end-user.
There are two additional link labels on the bottom of the image:
· Encrypt Section <section name> - If the end-user clicks on this link, the whole <section name> will be encrypted in the “web.config” file and the text of the link label will change in: Decrypt section <section name>. The content of the encrypted section can only be seen using the console. For production environment, it should be encrypted while for development environment it should be decrypted for the ease of debugging.
· The Add New Item link label permits adding new settings in the current section. This is not recommended for the end-user to do.
The next 2 setting groups contain information about the Database/Dictionary connection and about the user used during the installation for impersonation.
· The connection strings section sets the connection strings for the “Database” and “Dictionary” - the GlobalCacheDatabase connection settings are set together with the Dictionary. Clicking on the text boxes will open a wizard that will guide the user through-out. This wizard is identical to the database/dictionary wizard of the installation kit where you choose the server, user name, password and database to be connected. 
· In the identity section, the only thing that an end-user can change is the username and password settings.
After a website is selected, the third tab, Setup, will change its name to Setup [WebSiteName] and at the same time it becomes available.
· After you click on the Setup [Website Name] tab the setup view appears. In this view 3 options, Clear the Global Cache, Compile the whole DICTIONARY, and GetAll Errors are available:

· Clear the Global and Local Cache – deletes from the DICTIONARY all the STARLIMS compiled assemblies, preparing it for a new, fresh compile. A username and password are required.
· Compile the whole DICTIONARY – takes all the STARLIMS code and compiles and deploys it in the Global and Local Cache, and at the same time presents in the box underneath the result of the compilation: the script name and the compiler result (“OK” written in green or a descriptive error in red).
· Get All Errors – gathers all the errors that happened during the compilation process and shows them in an editor where the user can add his own commentaries and in the end print or send it by mail to the right person.
[image: ]WARNING The text box containing the URL to the website should not be changed by the end-user.



[bookmark: _Toc2086735]UTC Database Time Considerations
If you want to set the database time as UTC time, then changes to the database connection strings are needed. 
Open the STARLIMS Management Console and add “useUTC” to all the database “ProvideName” connections as shown below. The result should be: keepAlive; useUTC.
[image: ]
Figure 5: STARLIMS Management Console, database ProvideName connections with useUTC
For more information about UTC time, take a look at the document called “How to store UTC in database” that typically comes with the installation documents or request it from your Abbott Informatics representative.
[bookmark: _Toc430337321][bookmark: _Toc2086736]Antivirus Software Considerations
In cases when antivirus software is monitoring the application server, the following folders and their sub-folders need to be added to the antivirus exclusion list:
· Application folder
· Work path folder (if outside application folder)
· User log folder (if outside application folder)
· Windows TEMP folder (if possible, it is used by Crystal Reports engine)
[image: ]NOTE For NLB setups, repeat this process on each application server in the cluster.
[bookmark: _Toc430337323]

[bookmark: _Toc2086737]Production Systems Considerations
To configure your STARLIMS system for a Production environment, please refer to the corresponding section from User Documentation included with the media. Currently, the section’s path is CONFIGURATION > STARLIMS Configuration > Application Configuration > Production Mode.
[bookmark: _Toc2086738]Cybersecurity considerations
To ensure that your STARLIMS system is secure, please refer to the corresponding section from User Documentation included with the media. Currently, the section’s path is CONFIGURATION > STARLIMS Configuration > Cybersecurity.
[bookmark: _Development_Systems_Considerations][bookmark: _Toc430337324][bookmark: _Toc2086739]Development Systems Considerations
To configure your STARLIMS system for a Development environment, please refer to the corresponding section from User Documentation included with the media. Currently, the section’s path is CONFIGURATION > STARLIMS Configuration > Application Configuration > Development Mode.


[bookmark: _Report_Printing_Service][bookmark: _Toc430337325][bookmark: _Toc2086740]Report Printing Service Installation
This component is used for processing batch print requests.

Please refer to the corresponding section from User Documentation included with the media, for the complete list of installation and configuration steps.
[bookmark: _Manager_Service_Configuration][bookmark: _Toc429560165][bookmark: _Toc430337330][bookmark: _Toc2086741]Manager Service installation
This component is used for starting the STARLIMS Worker Process, in order to execute business logic scripts
· periodically with the desired frequency
· in an unattended manner
· with the ability to scale out to different server, to conserve resources on main app servers
[bookmark: _Toc430337338]Please refer to the corresponding section from User Documentation included with the media, for the complete list of installation and configuration steps.


[bookmark: _Toc2086742]Post Installation Actions
[bookmark: _Toc430337339]The following pertains to installations that include SDMS. After you install the SDMS website, you will integrate the LIMS and SDMS installations.
[image: ]NOTE SDMS has its own setup kit and setup guide. For a complete discussion of the SDMS installation process, read the document SDMS Installation and Configuration Guide.
[bookmark: _Toc2086743]Link STARLIMS and SDMS WebSites
1. Open the STARLIMS application in Internet Explorer (IE) and go to Utilities > Settings > Enterprise Setting.
2. Find the setting SDMSINSTALLED and set Y as the value.
3. Find the setting SDMS_URL_CLIENT and change its value to the URL of the SDMS site.
4. Find the setting SDMS_URL and change its value to the local URL of the SDMS site (typically http://localhost/starlims.sdms if both websites are on the same box, or the same as SDMS_URL_CLIENT if they are on different boxes).
[bookmark: _Toc430337340][bookmark: _Toc2086744]Synchronize Sites, Groups, and Users
1. Open STARLIMS in Internet Explorer and connect as SYSADM /[password]/ SITE1 (this is the only account that is available out-of-the-box in both systems).
[image: ]IMPORTANT The SYSADM password must match on both systems. By default, SDMS ships with user SYSADM and password  #St@rL1ms   Since your STARLIMS product ships with a different password for SYSADM, please follow the steps below to synchronize the two passwords:
1.1. Open Internet Explorer
1.2. Navigate to SDMS Web site
1.3. Login as SYSADM / #St@rL1ms  under the Site Global
1.4. Go to Administration > Users
1.5. Click <Edit> for user SYSADM
1.6. Change the password so it matches the one in STARLIMS
1.7. Click <OK>
1.8. Logout and close IE

2. [bookmark: _Ref188337987][bookmark: _Toc228679247]Open and close the Sites application, typically found in the Organization > Resources category. This will trigger the synchronization of the whole tree of Sites, Groups, and Users from STARLIMS to SDMS.
[image: ]NOTE The synchronization is carried out in the background, and it leaves progress messages in SYSADM’s log file. Check the log file to ensure that the operation finished successfully, without errors. To check the log file, open the Designer and go to ”Server Log” in the bottom tab, then pick SYSADM from the list of Users.

3. Open Users Management application, and select user STARLIMS in the grid. Then click on <Sync To SDMS>. Ensure there are no errors in the STARLIMS log file.
[image: ]NOTE The system ships with the predefined accounts SYSADM and STARLIMS. This is a convention that enables administrators to bootstrap the system. After the system is installed and functional, and after synchronizing Users and Sites as described above, it is recommended to a) change the password for the STARLIMS account from the Users Management application, and b) retire the SYSADM account. If SYSADM needs to remain active, at a minimum change its password to be more secure. 
[bookmark: _STARLIMS_Manager_Console][bookmark: _Registering_the_STARLIMS][bookmark: _Toc430337343]

[bookmark: _Registering_the_STARLIMS_1][bookmark: _Toc2086745]Registering the STARLIMS Installation
The following instructions help you register and activate your STARLIMS installation.
A STARLIMS User License is based on concurrent sessions and classified as either Full Users (license code SL-FCL such as for Power Users, Internal Users, and Regular Users in legacy systems) or Data Users (license code SL-DCL such as for Limited Users, External Users in legacy systems). 
There are additional license types for: Batch, Instrument Connections, Mobile Runtime, Standard, Mobile and/or HTML5 Designer, Advanced Analytics, SDMS and ELN, SAP, Validation Kit, and so on.  
[image: ]TIP See your sales invoice to determine the number of users you purchased in each class.
Without registration, the system is limited to two users for each type of license. A non-registered product should be used only for evaluation purposes and should not be used in a production environment. 
To register, navigate to http://yourServerAddress/yourWebSiteName/register.aspx. Click Current License to view your current user license and access the installation Key. Copy the installation key to the clipboard.
1. Navigate to the STARLIMS Support Page (https://support.abbottinformatics.com/), and create a new ticket. 
2. If you are the Requester leave the field blank, your name will appear automatically once the ticket has been submitted.
3. Select License Key Request under the Form field. 
4. Select the License type. Required. For the STARLIMS type, provide the License Environment Usage and enter the Installation Key.
5. Enter the remaining ticket data, and then click Submit as New.	
The ticket is automatically assigned to one of the License Keys Tiers depending on region of your organization.
· Americas, License Keys (Americas) - Tier
· AP, License Keys (AP) - Tier
· EMEA, License Keys (EMEA) - Tier
License Key Requests for Advanced Analytics Server & Builder and Data Innovations are routed directly to License Keys (Americas) - Tier.
[image: ]NOTE You can override the default routing by using the Assignee field. However, we do not recommend overriding the Assignee, unless it is absolutely necessary. For example, if a ticket is created outside of business hours and the activation key is needed immediately; then, you may manually update the Assignee.
[bookmark: _Toc2086746][bookmark: _Toc430337344]Activate License

When you receive the activation key, copy and paste it into the text box in the Registration Page (http://yourServerAddress/yourWebSiteName/register.aspx), and then click Activate.

Be aware of the following:

· Each key is for one specific STARLIMS installation. Multiple system (e.g., production, testing, and training) require separate activation keys.
· Configure both full and data users from within STARLIMS in the Users Management application.
· Configure named users per feature from within STARLIMS in the Features Users application.
· Some STARLIMS features, including Advanced Analytics, Mobile, and HTML must be licensed for each user.

If you change the database/dictionary connection string you will invalidate your license and you will need to request a new activation key. Please consider this when planning your database management operations.

[bookmark: _Toc2086747]Client SETUP
Client computer software configuration includes:
· Configuration of .NET permission of the STARLIMS client 
· Installation of the Crystal reports runtime viewer
· Installation of the SDMS file grabber utility (see SDMS manuals)
· Installation of SDMS office add-ins (see SDMS manuals)
[bookmark: _Toc430337345][bookmark: _Toc2086748]Configuring the STARLIMS client
You should have administrator privileges to perform the client configurations.
[bookmark: _Toc228792638][bookmark: _Toc229203163][bookmark: _Toc229203382][bookmark: _Toc229204001][bookmark: _Toc229208395][bookmark: _Toc229209029][bookmark: _Toc229235616][bookmark: _Toc229236420][bookmark: _Toc229988544][bookmark: _Toc234997704][bookmark: _Toc244674816][bookmark: _Toc244682475][bookmark: _Toc244684896][bookmark: _Toc244687918][bookmark: _Toc245110371][bookmark: _Toc245114303][bookmark: _Toc249867248][bookmark: _Toc252185709][bookmark: _Toc253738971][bookmark: _Toc256520033][bookmark: _Toc256521778][bookmark: _Toc256585561][bookmark: _Toc256588935][bookmark: _Toc256589398][bookmark: _Toc256592290][bookmark: _Toc256595765][bookmark: _Toc256596971][bookmark: _Toc256677775][bookmark: _Toc257368619][bookmark: _Toc257371182][bookmark: _Toc257371271][bookmark: _Toc258501699][bookmark: _Toc258502456][bookmark: _Toc258507311][bookmark: _Toc258507881][bookmark: _Toc258508135][bookmark: _Toc258582675][bookmark: _Toc258589097][bookmark: _Toc430337346][bookmark: _Toc2086749]Configuring .NET permissions
Ensure .NET Framework 3.5 is enabled on the client computer:
1. Open Control Panel. 
2. Locate Programs and Features > Turn Windows Features On or Off. 
3. Make sure Microsoft .NET Framework 3.5 is enabled.
Ensure STARLIMS is in the list of trusted sites:
1. Open Internet Explorer.
2. Go to Security at Tools > Internet Options to manage trusted sites.
3. Click on Trusted Sites, then click the Sites button.
4. Enter the URL where the STARLIMS installation is located into your trusted sites list.
[bookmark: _Toc2086750]Opening STARLIMS The First Time
Open STARLIMS for the first time on a client as follows:
1. Open Internet Explorer and enter the URL for the STARLIMS website.
2. Click Internal Lab Users in the upper-left part of the screen, and select Browser Configuration. (Or, if you log on, you encounter an Internet Explorer warning message that will redirect the browser to the same place, which is a troubleshooting page.)
3. Click on the script hyperlink in the page. Choose "Save Target As..." to save the file ConfigSTARLIMSCAS.vbs locally.
[image: ]TIP Save a script to run from your computer in a path that is easy to access using the command prompt, such as the C: drive. Open the command prompt with administrator privilege (Run as administrator). Navigate to the saved .vbs file, and run the file.
4. Go to the Windows Start button > All Programs > Accessories, right-click the Command Prompt application, and choose Run as administrator.
5. At the command prompt, run the cscript utility with the full path and name of the file saved above, for example:
cscript "C:\Temp\ConfigSTARLIMSCAS.vbs” <Enter>
6. Confirm the script executed without errors after it finishes. 
7. Close and reopen Internet Explorer, and login into STARLIMS.
[bookmark: _Toc430337347][bookmark: _Toc2086751]Installing the Crystal Reports Runtime Viewer
If STARLIMS does not find the Crystal Reports Viewer on the local client machine, it will ask the user whether to continue without it, or to Cancel and install it.
If Cancel is clicked, the browser will navigate to a page from where Crystal Reports Viewer can be downloaded and installed, by pressing the here hyperlink. In the dialog that follows click Run and the installer will guide you through the remaining steps in a friendly manner.
From the same page, the Barcode font can be downloaded and installed in a similar way.
[bookmark: _Toc430337348][bookmark: _Toc2086752]Configuring site security for Internet Explorer
For clients using Internet Explorer 9+, you must add the server on which STARLIMS is installed to the list of trusted sites, using following steps:
1. Open the Internet Explorer > Tools > Internet Options dialog box.
2. Click the Security tab.
3. Click the Trusted Sites icon.
4. Click the Sites button.
5. Type “http://[YourWebServer]” in the Add this website to the zone text box.
6. If necessary, uncheck “Require server verification (https:) for all sites in this zone.”
7. Click the Add button and then click the Close button.
Also, if the Internet Explorer pop-up blocker is turned on, you need to configure it to allow pop-ups coming from the STARLIMS website.
[bookmark: _Toc260039329][bookmark: _Toc264962043][bookmark: _Toc264976151][bookmark: _Toc264979931][bookmark: _Toc272401061][bookmark: _Toc272489736][bookmark: _Toc272489961][bookmark: _Toc293582351][bookmark: _Toc293929047][bookmark: _Toc293999962][bookmark: _Toc294096274][bookmark: _Toc294096331][bookmark: _Toc294096611][bookmark: _Toc294191452][bookmark: _Toc294191612][bookmark: _Toc295142262][bookmark: _Toc295143471][bookmark: _Toc309210985][bookmark: _Toc311190249][bookmark: _Toc311207909][bookmark: _Toc311208150][bookmark: _Toc311208279][bookmark: _Toc311208567][bookmark: _Toc360799813][bookmark: _Toc360799868][bookmark: _Toc360802291][bookmark: _Toc360803894][bookmark: _Toc361045185][bookmark: _Toc361057219][bookmark: _Toc361058067][bookmark: _Toc362249774][bookmark: _Toc362249912][bookmark: _Toc365034476][bookmark: _Toc365034701][bookmark: _Toc365471573][bookmark: _Toc365471630][bookmark: _Toc365471688][bookmark: _Toc365473284][bookmark: _Toc365473353][bookmark: _Toc365534446][bookmark: _Toc373912437][bookmark: _Toc373912525][bookmark: _Toc374440280][bookmark: _Toc406419169][bookmark: _Toc406422312][bookmark: _Toc430259022][bookmark: _Toc430259082][bookmark: _Toc430259257][bookmark: _Toc430261085][bookmark: _Toc430261860][bookmark: _Toc430268283][bookmark: _Toc430269147][bookmark: _Toc430269554][bookmark: _Toc430269625][bookmark: _Toc430269696][bookmark: _Toc430272265][bookmark: _Toc430272483][bookmark: _Toc430336644][bookmark: _Toc430336709][bookmark: _Toc430336858][bookmark: _Toc430337349][bookmark: _Toc260039330][bookmark: _Toc264962044][bookmark: _Toc264976152][bookmark: _Toc264979932][bookmark: _Toc272401062][bookmark: _Toc272489737][bookmark: _Toc272489962][bookmark: _Toc293582352][bookmark: _Toc293929048][bookmark: _Toc293999963][bookmark: _Toc294096275][bookmark: _Toc294096332][bookmark: _Toc294096612][bookmark: _Toc294191453][bookmark: _Toc294191613][bookmark: _Toc295142263][bookmark: _Toc295143472][bookmark: _Toc309210986][bookmark: _Toc311190250][bookmark: _Toc311207910][bookmark: _Toc311208151][bookmark: _Toc311208280][bookmark: _Toc311208568][bookmark: _Toc360799814][bookmark: _Toc360799869][bookmark: _Toc360802292][bookmark: _Toc360803895][bookmark: _Toc361045186][bookmark: _Toc361057220][bookmark: _Toc361058068][bookmark: _Toc362249775][bookmark: _Toc362249913][bookmark: _Toc365034477][bookmark: _Toc365034702][bookmark: _Toc365471574][bookmark: _Toc365471631][bookmark: _Toc365471689][bookmark: _Toc365473285][bookmark: _Toc365473354][bookmark: _Toc365534447][bookmark: _Toc373912438][bookmark: _Toc373912526][bookmark: _Toc374440281][bookmark: _Toc406419170][bookmark: _Toc406422313][bookmark: _Toc430259023][bookmark: _Toc430259083][bookmark: _Toc430259258][bookmark: _Toc430261086][bookmark: _Toc430261861][bookmark: _Toc430268284][bookmark: _Toc430269148][bookmark: _Toc430269555][bookmark: _Toc430269626][bookmark: _Toc430269697][bookmark: _Toc430272266][bookmark: _Toc430272484][bookmark: _Toc430336645][bookmark: _Toc430336710][bookmark: _Toc430336859][bookmark: _Toc430337350][bookmark: _Toc430337351][bookmark: _Toc218336940]
[bookmark: _Toc2086753]Installing the SDMS Documents Grabber and Office Add-ins 
For a complete discussion of the installation process for SDMS client-side components such as the Documents Grabber and Office Add-ins, read the document SDMS Installation and Configuration Guide.
[image: ]NOTE Since the Grabber is a client component, it is not recommended to be installed and run on the application server, but on front-end client machines.
[bookmark: _VSTO_Runtime_Installation][bookmark: _Toc218336943][bookmark: _Toc430337354][bookmark: _Toc2086754]Microsoft Word, Excel and Outlook Add-ins Installation
SDMS has add-in client applications that enable it to be integrated with Microsoft Office applications such as Word, Excel, and Outlook. These are an integral part of SDMS and enable uploading files, constructing reports or summary of documents without including all the available data, and working with pending document workflows.
Before installing add-ins for Microsoft Word or Excel, you need to install the Visual Studio Runtime (VSTO). See the document SDMS Installation and Configuration Guide.


[bookmark: _Toc430337359][bookmark: _Toc2086755]Installation Checklist

	STARLIMS Installation Checklist
	

	
	

	Restore databases (database servers)
	

		STARLIMS_DICTIONARY
	



	

	STARLIMS_DATA
	

	STARLIMS_SDMS
	

	Repeat for each of the planned sites e.g. Dev, Test, Prod
	

	 
	

	Install server components (application servers)
	

	Install the STARLIMS website
	

	Install the SDMS website
	

	
	

	Post installation actions
	

	Point IE to STARLIMS site(s) and configure .NET permissions and IE site security
	

	Link STARLIMS and SDMS websites
	

	Synchronize Sites, Groups, and Users
	

	Register STARLIMS installation
	

	
	

	Client installation
	

	Install Crystal runtime (client machines)
	

	Install SDMS Documents Grabber (Grabber machine)
	

	Install VSTO runtime, then install Word, Excel and Outlook Add-ins (Office Add-ins machines)
	

	
	

	Other components
	

	Manager Service (best to scale-out to dedicated server)
	

	Printing Service (best to scale-out to dedicated server)
	

	STARLIMS Console (application servers)
	


[bookmark: _Set_System_in][bookmark: _Toc430337361][bookmark: _Toc2086756]Troubleshooting Guide
This section documents how to troubleshoot installation issues, as well as how to check and repair essential components required by the STARLIMS system.
[bookmark: _Toc2086757][bookmark: _Toc142988515][bookmark: _Toc228679264][bookmark: _Toc430337362].NET Framework 1.1 or 2.0 instead of correct version on Client 
It is mandatory to have .NET Framework 3.5 SP1 installed on all clients accessing the STARLIMS application.
[bookmark: _Toc166481957][bookmark: _Ref174941302][bookmark: _Toc228679266][bookmark: _Toc430337363][bookmark: _Toc2086758]Running the STARLIMS WebSite Using HTTPS
If the STARLIMS website is running under HTTPS then on the client machines, the Internet Explorer option “Do not save encrypted pages to disk” should remain clear (see figure below). Otherwise the client system will not be able to load the XFD Runtime (STARLIMS Client component).
[image: C:\Users\codrecx\AppData\Local\Temp\SNAGHTML9c04e93a.PNG]
Figure 6:  Internet Explorer Options
[bookmark: _Ref174945301][bookmark: _Toc228679267][bookmark: _Toc430337364]
[bookmark: _Toc2086759]Underscore Characters in the STARLIMS WebSite Name
The name of the website should be limited to alphanumeric characters only. An underscore can be included in the name if desired, but if used then the start.lims directive must be added to the website URL in order to prevent HTTP errors caused by the URL encoding of special characters as percent strings:
http://[Server_name]/%5bwebsite_name%5d/start.lims
[bookmark: _Toc228679269][bookmark: _Toc430337365][bookmark: _Toc2086760]Trouble with Printing Reports
If you cannot print reports, for example, the preview screen opens without displaying the report, follow these steps for corrective actions:
1. Find the “Temp” directory situated in the Windows Folder, such as C:\Windows\Temp.
2. Right click on it and select Properties.
3. Click Security tab, add the NETWORK SERVICE account, and allow Full Control for that account.
If barcodes are not printed in PDF reports, you need to do the following:
1. Find the “Fonts” directory located in the Windows Folder, such as C:\Windows\Fonts.
2. Right click on it and select Sharing and Security….
3. [bookmark: _Toc188345401][bookmark: _Toc188345402][bookmark: _Toc188345403][bookmark: _Toc188345404][bookmark: _Toc188345405][bookmark: _Toc188345406][bookmark: _Toc188345407][bookmark: _Toc188345408][bookmark: _Toc188345409][bookmark: _Toc188345410][bookmark: _Toc188345411][bookmark: _Toc188345412][bookmark: _Toc188345413][bookmark: _Toc188345414]Click Security tab and add the NETWORK SERVICE account and then allow Full Control for that account.
[bookmark: _Toc228679271][bookmark: _Toc430337366][bookmark: _Toc2086761][bookmark: _Ref189642360]Cannot connect to MS SQL Server
If you have more than one instance of SQL Server installed on a machine, when setting up the database connections, include the instance name when specifying the database server.
The name must be entered in the following format:
MACHINE_NAME\INSTANCE_NAME
[image: ]IMPORTANT It is very important to include the backslash (‘\’) character and no other characters; you might see the server name specified in the MACHINE_NAME (INSTANCE_NAME) format, which will not work.
[bookmark: _Toc430337367][bookmark: _Toc2086762]Oracle errors
If your dictionary is Oracle and you experience errors such as the ones below:
· Attempted to read or write protected memory. This is often an indication that other memory is corrupt.
· ORA-01036: illegal variable name/number
· ROW-00001: Cannot allocate memory
Then change the Dictionary provider from OLEDB to Native Oracle. The easiest way to do this is open the STARLIMS Console and copy the values of ProviderName and ConnectionString settings from the GlobalCacheDatabase entry to the Dictionary entry.
[bookmark: _Toc228679279][bookmark: _Toc430337368][bookmark: _Toc2086763]HTTP 404 Not Found Issue
IIS uses by default the port 80. The network administrator has to make sure there are no other server applications using the port 80. The network administrator has to select an alternative port for the applications others than IIS that are using the port 80.
[bookmark: _Toc2086764]SSL ERROR 
"ILLEGAL OPERATION ATTEMPTED ON A REGISTRY KEY THAT HAS BEEN MARKED FOR DELETION. (EXCEPTION FROM HRESULT: 0X800703FA)"
Starting with Windows 2008, when the user logs off from the server, his profile is unloaded.
If the application pool is setup to use a domain user then we can get this kind of error in SSL:
Illegal operation attempted on a registry key that has been marked for deletion. (Exception from HRESULT: 0x800703FA)
This link shows how to prevent the unloading of the user’s profile:
http://blogs.msdn.com/b/distributedservices/archive/2009/11/06/a-com-server-application-may-stop-working-on-windows-server-2008.aspx
If the app pool is setup to use Network Service, then this issue doesn’t appear.
[bookmark: _Toc430337370][bookmark: _Toc2086765]Oracle 11g R2 errors
1. When selecting LONGVARCHAR fields from the database some records are null in STARLIMS even though they are not null in the database. 
For example: "select ORIGREC, ROW_DATA from AUDITTRL where ROW_DATA is not null" is returning null values for ROW_DATA
· The issue is caused by the OleDb driver version 11.2.0.1 
· To fix on 32-bit systems: apply patch# 10245350
· To fix on 64-bit systems: apply patch# 10245351
[image: ]NOTE The patch needs to be applied on the ORACLE client (on the Web application server).
2. ORA-01461: can bind a LONG value only for insert into a LONG column
To fix, run the statement: alter system set "_fix_control"='6990305:OFF';
3. ORA-03113: end-of-file on communication channel
· This may happen when doing UPDATE and the WHERE clause contains SELECT statements.
· To fix run the statement: alter system set "_push_join_union_view"=false scope=both;
[bookmark: _Toc430337371][bookmark: _Toc2086766]Too many active sessions on database server
When a STARLIMS system is in Development mode, the database server could experience session starvation. If that happens, open the STARLIMS Console and add the “Max Pool Size = 2” attribute to all connection strings. See Development Systems Considerations for details.
Since changing the database connection string invalidates your license, you will need to re-register your system as explained in Registering the STARLIMS Installation.
[bookmark: _Toc430337372]

[bookmark: _Toc2086767]Uninstalling STARLIMS
To uninstall STARLIMS, open the “Programs and Features” system application; click your STARLIMS instance in the list of installed applications; then click the Uninstall button. Follow through the wizard in order to have your STARLIMS system uninstalled.
The uninstaller removes all files and folders created during the original install. All other files and folders created after that, such as user logs, temp files, cached images and assemblies, and so on are left on disk and require manual removal.
Similarly, the STARLIMS Database and Dictionary are left unaffected by the uninstall process. If no longer needed, they must be deleted manually using the corresponding SQL Server or Oracle tools.
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[bookmark: _Toc2086768]Glossary
A
Advanced Analytics: Advanced Analytics software provides tools to analyze, visualize, and share LIMS data.
App: An App is a mobile application. In this document, App refers to the STARLIMS app.
B
Barcode: Barcodes are patterns encoded on labels which can be scanned by a barcode reader to record sample information into the LIMS. The scanning of barcodes is part of the logging in and/or receiving process.
C
Client Script: A JavaScript you create to run in the client browser.
Concurrent Data-User License: For users who need to create/view samples, results, and reports only.
Concurrent Full-User License: Controls the number of concurrent user sessions on your system. Users have full access to STARLIMS LIMS functionality.
Crystal Reports Viewer: The viewer can be downloaded and installed to allow the LIMS user to open and view crystal reports assigned to LIMS applications.
D
Dashboard: The control center for STARLIMS.
Database / Dictionary: See STARLIMS Database or STARLIMS Dictionary.
E
ELN: An Electronic Lab Notebook.
F
Form: An application window.
I
IDE: Integrative Development Environment - A platform used by developers to create applications for the STARLIMS system.
J
JavaScript: The standard scripting language for building HTML5 web applications.
JScript: The Microsoft implementation of JavaScript.
L
LDAP: Lightweight Directory Access Protocol.
LIMS: Laboratory Information Management System.
M
Mobile Solutions: STARLIMS mobile application.
N
NLB: Network Load Balancing.
O 
OOTB: Out-of-the-box (OOTB). A release of the STARLIMS vertical system based on the database/dictionary.
R
RAID: Redundant Array of Independent Disks.
Report Printing Service: A component used to process batch print requests.
S
Safe Designer: Protects the STARLIMS Designer from being modified by anyone without the proper credentials. Safe Designer elements are colored blue.
SDMS: Scientific Data Management System.
SSL: STARLIMS Scripting Language. It is used to configure actions and calculations in STARLIMS.
STARLIMS Database: which contains static and dynamic data such as clients, projects, tests, analytes, orders, results, and so on.
STARLIMS Dictionary: Database containing STARLIMS business rules, server scripts, client scripts, and client forms definitions.
STARLIMS Management Console: A console that can be used to inspect and modify settings including dictionary connection strings of an installed site.
STARLIMS Manager Service: A Windows service whose purpose is to run the Worker Process. As soon as the worker process finishes its job, the service will run it again.
STARLIMS Unified Platform: It incorporates Electronic Lab Notebook (ELN) functionality and a Scientific Data Management System (SDMS) in a single LIMS platform.
STARLIMS V11 Worker Process: Process that executes a script to run processes outside of the LIMS in the background.
U
Updater: An update wizard .bat file for upgrading from a previous version of STARLIMS.
URL: Uniform (or universal) Resource Locator. It is a formatted text string used by Web browsers, email clients and other software to identify a network resource on the Internet. Network resources are files that can be plain Web pages, other text documents, graphics, or programs.
User: A registered user on the STARLIMS system, that is, someone who can log on to the software in some capacity.
UTC: Coordinated Universal Time. A standard time used world-wide by common agreement.
V
VSTO: Visual Studio Runtime.
W
Worker Process: See STARLIMS V11 Worker Process.
X
XFD: XML Form Definition.
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